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I - LIST OF ELEMENTS

A) Elements

1. Interface

Graphic interface

Windows for :

 elements, stocks, flows, actions, procedures, arrays
 vectors, tunings, charts
 3D and 4D renders (OpenGL)  
 panorama, global zoom and sizes

2. Elements of calculation

Active elements

 Actions in :
 flow : normal flow that links stocks
 virtual flow : without linked stocks

 four types of action
 constant, array, scatter, procedure

Procedures allow to write the code :

 in this code all functions of the W-language, popular programming language, are available in 
French or English

 this code will be dynamically computed while computing according to the planned actions

Passive elements

 stock, can be both source and target of flows, and shadow stock
 mirror flow that links stock to mirror stock, and shadow mirror
 mirror stock, target of mirror flow, and shadow mirror stock
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3. Elements for result

Windows

 Messages
 Values
 Results

Static elements

 groups

Half-chartic dynamics elements

 Charts :
 curve
 scatter
 column
 columnpile
 pie
 candlestick
 barcharts
 minmax

 all the charts except scatter and pie display one cursor depending on the current time unit

chartic dynamics elements

 stocks, mirror stocks, flows and virtual  flows
 3D or 4D renders (OpenGl, multibody)

Frames

 they can handle the elements they contain 
 they can display the messages written while computing
 they can display images

Animated and speaking characters

 they are associated to frames
 they are animated and can speak messages displayed in frames
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B) Graphic display

1. Dynamic display

The display of the model is dynamic : for each time of one cycle, the display of elements is proportional to 
the values respectively calculated and stored while computing :

 a stock is represented by a rectangle, its surface is proportional to its value

 a flow is represented by two arrows which indicate the direction of transfer, located on both sides 
of a circle that has its diameter proportional to the value returned by the flow

 the value returned by one flow is represented by one circle between the incoming and outgoing 
arrows of the flow, its size, color and style can vary

 the causalities in a flow, when the return value of one action gets values of other variables (flows 
or stocks), are displayed as lines (B-Splines) between the centre of the circle of the flow to those 
variables

 3D render may be animated by values of stocks or and flows

 frames can display messages written while computing

 frames can display characters that can read messages written while computing

Four stocks and two flows : the flow FB gets the values of the stock SB and the flow FA
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2. Static display

 The values of stocks and flows are displayed in charts

 Stocks, flows and period can be selected for each chart

 Charts are overlapped in the model
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II - HANDLING ELEMENTS

A) Selection of elements

Handling description is common to all types of element

1. Selection of one element

 left-click on the element
 for one stock, click on its base only
 for one flow, click on the centre of the circle, or one dot or one arrow

2. Add one element to the selection

 press the Ctrl key and left-click on the element
 to unselect one selected element press the Ctrl key and left-click on the element

3. Select several elements

Lasso method :

 left-click on the model on the top left corner of the lasso
 drag and drop the mouse to the bottom right corner of the lasso
 release the mouse

4. Select all elements

 press the Ctrl+A keys

5. Unselect selected elements

 left-click on the model outside the rectangle of the selection
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6. Appearance of selected elements

Selected elements
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B) Move elements

1. Move one element

 Click on the element and drag and drop it

2. Move several elements

 select the elements, drag and drop the rectangle of the selection

3. Move the elements around the centre of the selection

 select the elements
 press the Shift key and hold it
 drag and drop one of the selected elements, all directions are allowed
 release the Shift key

Four stocks a, b, C, D,
are copied as  a[1], b[1], C[1], D[1],
and then flipped over the vertical and horizontal axis
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4. Move elements with the 'Move, setup elements' window 

 to open the  'Move, setup elements' window :
 click on the button 'Move elements' from the tool bar

Toolbar and 'Move selection' button

'Move, setup elements' window 

 adjust the factor with the spin 'factor'
 select one or more elements in the model
 drag the mouse on the x-axis to move the elements to the left or right
 drag the mouse on the y-axis to move elements up or down
 move the wheel of the mouse  to resize the elements (width and height)

o for stock : only the width will be adjusted
o for chart and render : width and height will be adjusted
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C) Fix the position of one or more elements

 The fixed element cannot be moved with the mouse
 it can only be moved with the 'Move, setup elements' window
 it can be resized with the mouse

1. Fix the position of one or more elements

 select one or more elements
 select the 'Fix position' option from the popup menu of the selection
 or use the 'Fix position' button from the toolbar (pin button)

A small triangle to the left of the name of the element shows that its position is fixed

2. Free the position of one or more elements

 select one or more elements
 select the 'Free position' option from the popup menu of the selection
 or use the 'Free position' button of the toolbar (pin button)
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III - DESCRIPTION OF ELEMENTS

A) Stocks

A stock can be simultaneously the source and the target of one or several flows.
Its initial value may be initialized for t = 0 :

 Note : mirror stock
 a mirror stock may be the target of one or more mirror flows,

that can only have stocks as sources
 its value represents the sum of its source stocks for the current unit of time
 this sum is calculated for each unit of time after the calculation of all the actions

Stocks can be enabled or not, vectorized or not.

B) Flows

A flow links two stocks : a source stock and a target stock.
A stock can be both source and target of one flow.
It may contain one or more actions.

 Note : virtual flow
 a virtual flow is a flow that doesn't flow stocks

 Note: mirror flow
 a mirror flow has a stock as source and a mirror stock as target

Flows can be enabled or not, vectorized or not. 
Actions of the disabled flows will not be calculated.
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C) Actions

An action is defined  by :

 temporal parameters that determine when it will be calculated

 a return value, also called transfer value : it will be subtracted from the value of the source stock 
and added to the value of the target stock, while computing

1. Temporal parameters

 Chronology (Chrono)
Set the order of calculation of the action when multiple actions are performed simultaneously

 Chronology random (?Chrono)
When this parameter is filled in, the chronology of the action (Chrono) varies randomly between 
'Chrono' and '?Chrono?'

 Start
Set the unit of time for the first calculation of the action in one cycle

 Interval
Set the interval of repetition of the action, in unit of time, in one cycle

 Repeat
Set the number of executions of the action in one cycle

 Type of cycle
Set the type of cycle of the action :
 default cycle
 float default cycle
 float filtered cycle

 Filtered cycles
Set the cycles where actions will be calculated
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2. Types of return value

 constant

 a variable value from an array of constant values
The index of the array that gets this value is the current running number in a cycle of this action

 a variable value from an array of a couple of constants (x, y)
The index of the array that gets this value ( = output y) is by default those that corresponds to the 
current value of the flow ( = input x)

 a value returned by a procedure 
This procedure contains source code, it is compiled and executed dynamically for all the units of 
time defined by the temporal parameters

D) Charts

Charts display values of stocks and flows for a defined period of time

Type of chart :

 curve, column, column pile, candlestick, bar charts, minmax
A cursor indicates the current unit of time

 scatter

 pie
Returns only the average values of each element for the defined period,
only positive values are displayed

E) Multibody : 3D and 4D render

A 3D render contains primitives of the OpenGL chartics library : sphere, cone, cylinder, etc...

Each primitive has parameters that may vary depending on the value of stocks or flows.
An animated 3D render, depending on the unit of time, is a 4D render ( n dimensions).

F) Frames

A frame can contain stocks, flows, charts and renders.
A frame can display text, images and results. 
An animated character with a frame can speak messages written while computing.
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G) Groups

Default groups :

 stocks
 mirror stocks
 flows
 mirror flows
 charts
 renders
 frames

Other groups can be created specifically for selected elements.
The groups can display, hide, enable and disable elements simultaneously.
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IV - CREATE ELEMENTS WITH LEFT TOOLBAR

A) Left toolbar

Left toolbar to create elements

To create elements with the buttons of the left toolbar :

 click on one button of the toolbar
 click on the model to create the element

or for buttons : flow, vector, dictionary, chart, export, delete :

 click on one button of the toolbar
 select more than one element (lasso method)
 click on the rectangle of selection

To stop creating elements with the toolbar :

 press the Escape key or :
 right-click on the model or :
 click again on the button of the toolbar
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Left toolbar to create elements

1. Create elements

Buttons : Stocks and flows

 New flow (normal or virtual)

o click on this button, then :

o click on the model ( to create virtual flows) , or :

o click on one source stock (you can click on the model to create points) and on one target 
stock, or :

o selected several source stocks, click on the rectangle of selection,
(you can click on the model to create points),
click on the target stock

 New point (point of flow)
o click on this button, then click on one flow (normal or virtual) to add point

 New stock
click on this button, then click on the model to create stocks

 New mirror flow
o click on this button, click on one or more source stocks, click on the target mirror stock

 New mirror stock
o click on this button, then click on the model

 New shadow
o click on this button, then click on one stock or flow, or :
o select several stocks and flows and click on the selection
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Buttons : Vectors, Frames, 4D render, Dictionary, Chart, Export, Delete

 Assign, Enable and Disable one vector
o click on this button, then :
o click on one stock or flow or :
o select (lasso method) several stocks or flow and click on the rectangle of selection

 New frame
o click on this button then click on the model

 Redirect results, Cancel results redirection
o click on this button, then :
o click on one frame, or :
o select several frames (lasso method) and click on the rectangle of selection

 New 4D render
o click on this button then click on the model

 Add to dictionary, New chart, Export data, Delete
o click on this button, then :
o click on one element, or :
o select several elements (lasso method) and click on the rectangle of selection
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V - MODIFY ELEMENTS WITH RIGHT TOOLBAR

A) Right toolbar

Right toolbar to modify elements

1. Modify elements

To modify elements with the buttons of the right toolbar :

Buttons : Rename, Modify

 click on one button of the toolbar
 click on one element to rename or modify it

Other buttons :

 click on one button of the toolbar then :
 click on one element

or :
 select more than one element (lasso method)
 click on the rectangle of selection
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VI - CREATE ELEMENTS WITH POPUP MENUS

A) Stocks

1. Create a stock

 select option 'New stock' from the popup menu of the model
 enter the name and the initial value of the stock

Popup menu of the model

The stock is displayed as a rectangle : the basis, it contains its name.

 The value of the stock is represented by a rectangle above or below the basis for a positive or 
negative value
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1.1 Create a shadow stock

Shadow stocks can be used to share stocks in several views.

 click on the icon 'Shadow on stock or flow'
 click on a stock or :
 select several stocks and click on the selection
 assign or not the shadow stock in another view to continue the model

Note :  a stock which has shadow is displayed with the char '1s' on left side of its basis :
the number '1' indicates the number of shadows for this stock, can be 2, 3, …

Note : a shadow stock is displayed with the char 's' on the right side of its basis, its basis is hatched.

2. Rename or change the initial value of one stock

 left-click on the stock
 press the F2 key or :
 select the option 'Rename' from the popup menu of the stock or :
 select the stock in the 'Elements' window and press the F2 key
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3. Resize a stock

Select the stock, two handles are displayed on the right side :

 the top handle changes the width and the height of the rectangle value
 bottom handle changes the width of the basis
 drag and drop one of the handles to adjust the rectangle value or the basis

Stock, selected stock with handles
New basis, new rectangle value

Note :when the rectangle value is resized, the char 's' is displayed on the right side of the rectangle value

4. Popup menu

 select one or more stocks
 right-click on one selected stock or :
 select one or more stocks in the 'Elements' window
 right-click on the selected stocks in the table of stocks
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Popup menus of one stock

Options

 See next chapters

Columns of the table 'Stocks' of the 'Elements' window

 'E' Enables or disables stock 
 'S' Shows (displays) or not stock
 'C' specific color of the stock which can active or not
 'V' veils or not the stock : it will be displayed by a small square, with no name and no value
 'Ve' actives or not vectorization of the  stock

One veiled stock
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5. Specific color

 select one or more stocks
 select 'Specific Color' from the popup menu of a stock

'Specific color' window

 select an attribute
 click on the color rectangle to change it
 edit Value width if necessary
 if you want to apply the changes to the other selected stock, check the interrupts of the attributes
 save with the 'Apply …' buttons
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B) Mirror stocks

1. Create one mirror stock

 select 'New mirror stock' of popup menu
 enter the name of the mirror stock, it is represented by an ellipse that displays its name 
 the value of the mirror will be represented by an ellipse :

this value will be equal to the sum of its source  stocks

Popup menu of the model, new mirror stock

1.1 Create a shadow mirror stock

Same way as shadow stock.

2. Rename a mirror stock

 left-click on the mirror stock
 press the F2 key or :
 select the 'Rename' option from the popup menu of the mirror stock or :
 select the mirror stock in the 'Elements' window and press the F2 key

3. Resize a mirror stock

 same way as normal stock
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4. Create a mirror flow

 select a source stock
 select 'New mirror flow' from the popup menu of the stock 
 enter its name
 left-click on the model to insert points between the source stock and target mirror stock
 click on the target mirror stock

Create a mirror flow
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5. Create simultaneously several mirror flows

 select source stocks or :
 select all the elements with the Ctrl+A keys
 select the 'New mirror flows' option from the popup menu of the target mirror stock 'Sm'

Selection of source stocks, new mirror flow with popup menu of target mirror stock 'Sm'
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6. Reassign the source or target stock

 drag and move the arrow on the new source stock or the new target mirror stock

 Note : for cycle 1 and time unit 0:
 the displayed values of the stocks correspond to their initial values
 the displayed values of the mirrors stocks correspond to the sum of the initial values of  the 

sources stocks only if the model is computed

7. Hide, display, delete mirrors flow

 select all the elements with Ctrl+A or :
 select the source stock of the mirror stock
 select the option from the popup menu of the mirror stock
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8. Moving a mirror flow

 drag and drop one of the points of the mirror flow

9. Popup menu of a mirror flow

 select one or several mirror flows
 right-click on a point of a selected mirror flow or :
 select one or several mirror flow in the 'Elements' window
 right-click on a mirror flow selected in the table of the mirror flow

Popup menus of one mirror flow
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C) Flows

1. Create one flow

 select 'New flow' in the popup menu of the source stock
 enter the name of the flow
 left-click once or several times on the model to create points between the source stock and the 

target stock
 click on the target stock of the flow

Popup menu of the source stock

1.1 Create one shadow flow

Same way as stock
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2. Popup menu of a flow

 select one or more flow in the model
 right-click on a flow, point or arrow of a selected flow or :
 select one or several flows in the 'Elements' window
 right-click on a selected flow of the table

 see details of the options in the next chapter

Popup menus on a flow, point or arrow
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Columns of the 'flows' table of the 'Elements' window

 'E' flow in or out of service
 'S' Show or not the flow
 'C' active or inactive specific color
 'Vi' normal or virtual flow
 'Ve'  vectorized or unvectorized flow

3. Rename a flow 

 select 'Rename' from the popup menu or :
 select a flow and press the F2 key or :
 select a flow in the 'Elements' windows and press the F2 key

4. Reassign one stock of one flow

 drag and drop the arrow of the flow on a new source or target stock
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5. Redirect results

The result messages written by the Aresult(x,message) function are displayed in the Result(x) window
One frame can display result displayed in one Aresult(x) window.

Redirect result messages to another 'Results' window :

 select one or more flows in the model
 select the 'Redirect results' option from the popup menu of a flow or :
 select one or several flows in the 'Elements' window
 select the 'Redirect results' option from the popup menu of the table
 enter the new number of the 'Results' window
 save, compute the model, open Result(x) window from the Aresult() window
 to cancel the redirection :
 select the 'Cancel results redirection' option

'Results redirection' window

'Aresult()' and Aresult(0) windows, Frame displays message from the Aresult(5) window
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6. Points and arrows of flows

A flow is represented by at least by one circle and two arrows, its name is displayed in the circle.

An arrow goes in the circle, the other one goes out :

 the stock connected to the incoming arrow is the source stock of the flow
 the stock connected to the outgoing arrow is the target stock of the flow

By default the colors of incoming and outgoing arrows correspond to the colors of the negative and 
positive values of the stocks.

To improve the readability of the model, add points :

 select the 'New point' option from the popup menu of the flow

Points and arrows can be displayed, hidden or deleted.

 Note : when one arrow is hidden it is no longer possible to use it to reassign the flow to another 
stock by drag and drop

Popup menus on a point and an arrow
on right, the output arrow is hidden
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7. Move the circle of the flow on another point 

 drag and drop a corner of the focus rectangle containing the selected circle on another point :
do not click on the centre of the circle, but on one side

Moving the circle of the 'ab' flow on the point on its right

 

 Note : observe the difference of size of the two squares of selection :
- the left square selects the circle to move
- the right selects the flow to move
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8. Specific color

 select one or more flows in the model
 select the 'Specific color' option from the popup menu of one of the selected flows

'Specific color' window for flows

 click on one attribute
 click on the color column to change the color
 select the style in combo
 check interrupts to apply attributes to other selected flows
 save with the 'Apply …' buttons
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D) Virtual flows

A virtual flow is a flow that doesn't link stock, its return value is not transferred.

1. Create one virtual flow

 select 'New virtual flow' from the popup menu of the model
 enter the name
 validate

Popup menu : New virtual flow

1.1 Create a shadow virtual flow

Same way as stock
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2. Change the type of one flow

 Check or not the 'Virtual flow' option from the popup menu of the flow
 after changing from virtual to normal flow, drag and drop the arrows or the points to source and 

target stocks

Change the type of a flow
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E) Frame

A frame can move elements, display static and dynamic messages, display animated characters, images.

1. Create one virtual frame

 select 'New frame' from the popup menu of the model
 enter the name
 validate

Popup menu : New frame

New frame (when clicking on the Options button) window 

See more in 'Manual Part 08 - Frames'
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F) Render

A render can display 3D procedural animation with primitives of the graphics library OpenGL.

1. Create one render

 select 'New Render' from the popup menu of the model
 enter the name
 validate

Popup menu : New render

See more in 'Manual Part 09 - Render'
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VII - EDIT THE ELEMENTS 

A) 'Elements' window

This window allows editing the elements and selecting them in the model.

Open the 'Elements' window :

 select the 'Elements' option from the 'Windows' menu or press the E key
 select a plan in the 'Elements' window
 select one or more elements in the table
 selected elements in the table are selected and displayed in the model if the pin is not enabled

'Elements' window, pin of the model not disabled

1. Pin of the window 'Elements'

 the pin freezes the plan and the selected element
 if the pin is disabled, a selected element in the model will be selected and displayed in the 

'Elements' window
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B) Main menu Edit 

 Select the 'Edit' option from the menu from TRUE

Main 'Edit' menu

1. Duplicate elements

 select one or more elements in the model
 select the 'Copy' and 'Paste' options or :
 press the Ctrl+C and Ctrl+V keys

The name of duplicated element will be indexed on the original one.

Example: the stock b is duplicated three times
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2. Preserving the integrity after duplication

When the elements are duplicated, all assignments and all the references are automatically preserved. 

Example of duplication of elements

 Notes :
 when a stock is duplicated with its flow, the new stock is linked to the new flow
 when a chart or a render is duplicated with its stocks or flows, the new chart or render 

contains all the news duplicated elements
 if all the elements of a group are duplicated, the group will also be duplicated
 procedures containing names of duplicated elements will be updated

3. Delete elements

Remove one or more elements :

 select one or more elements
 select the 'Delete' option from the Edit menu or :
 press the 'Delete' key or :
 select the 'Delete' option from the popup menu of the model or :
 select the 'Delete' option from the popup menu of the element to delete or :
 select the elements in the 'Elements' window and :
 select the 'Delete' option from the popup menu of table or :
 use the Delete button from the left toolbar

 Note : when all elements of a group are deleted, the group is deleted
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4. Restore deleted elements

Restore one or more deleted elements

 press the Ctrl+U key or :
 select the 'Undelete' option from the main Edit menu

'Deleted Elements' window

 select the elements to restore 
 select the option 'Undelete' from the popup menu

If several elements were deleted simultaneously and they are simultaneously restored, the associations 
between these elements are preserved.

Definitively delete one or more elements

 select the elements to delete
 select the 'Delete …' option

 Notes:
Several lines can simultaneously be selected in the table

The deleted actions are displayed in green : they can be restored only in the 'flows' table

The deleted elements are stored in files located in the Dictionary folder

Those files can be shared by other instances of TRUE, the 'Deleted Elements' window is updated 
every three seconds
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VIII - GROUPS

The elements belonging to a group can be enabled or not, hidden or not.
One element may belong to several groups.

Opening the 'Elements' window :

 select the 'Elements' option from the 'Windows' menu or press the E key
 click on the 'Group' button of the 'Elements' window

A) Default groups

They are displayed in the 'Default groups' table of the 'Group' plan

'Elements' window, Group plan

Columns

 'E' : enables or not the elements of the selected group
 'S' : shows or not the elements of the selected group
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B) Groups

1. Create a group from them model

 select one or more elements in the model
 select the 'New Group' option from the popup menu of the model
 the group is created and displayed in the 'Groups' table of the 'Elements' window
 select the group in the 'Elements' window
 press the 'F2' key to rename the group

'New Group' option from the popup menu
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2. Create a group from the 'Elements' window

 select in the model the elements to be added to the new group
 select the 'New' option from the popup menu of the table of groups
 the group is created and displayed in this table

Table of the groups and popup menu

3. Popup menu

 Enable/Disable : enable or disable the elements of the selected group
 Show/Hide : show or hide the elements of the selected group
 Update with current selection : adds or removes one or more elements in the group

4. Update the group with the selected elements

 Select one group in the table
 the elements are selected in the model
 unselect and/or add elements
 select the 'Update with the current selection' option
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IX - DICTIONARY OF ELEMENTS

The dictionary is shared by all the models.
You can store elements of a model and import them into another model.

Directory of the dictionary:

 default directory: .. \ TRUE \ Dictionary
 select the 'Directories' option from the 'Options' menu to change the path
 it contains files of the deleted elements
 it may be shared with other instances of TRUE
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A) Store elements in the dictionary

Store in the dictionary:

 select one or more elements in the model
 select the 'Store in dictionary' option from the popup menu of the model
 Enter a name associated with this selection

Open the 'Dictionary' window and add a comment:

 select the 'Dictionary' option from the 'Window' menu or press the 'D' key
 select one line
 enter a comment in the box under the table

Selection of elements, popup menu of the model design, Dictionary window

 Note: when all the elements of a group are stored in the dictionary, the group is also stored
 Note: the contents of the 'Dictionary' window is refreshed every three seconds
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B) Import elements from the dictionary 

Open the 'Dictionary' window and import into the model :

 select the 'Dictionary' option from the 'Window' menu or press the D key
 select one line
 select the 'Import' option from the popup menu or :
 drag and drop the selected line in the model in the model

'Dictionary' window
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